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Overview 

Stellar Mail Converter software converts mailboxes from Apple Mail (MBOX, EMLX), Thunderbird 

(MBOX), PostBox (MBOX), Outlook 2011 Backup File 2011 (OLM), Eudora (MBOX), SeaMonkey 

(MBOX), MailMate (EML), Outspring Mail (EML, F.EML) and Opera Mail (MBS) to Apple Mail (MBOX) 

and Outlook 2011 (RGE). You can import converted mailboxes in Apple Mail / Outlook 2011 to view 

complete mail body, including attachments. The software converts all emails, including attachments, 

without making any changes to the folder organization. 

What's New in this version? 

 Supports preview of converted mails. 

 New and enhanced GUI. 

 Converts Eudora (MBOX) to Outlook 2011 (RGE) as well as Apple Mail (MBOX) 

 Converts SeaMonkey (MBOX) to Outlook 2011 (RGE) as well as Apple Mail (MBOX) 

 Converts MailMate (EML) to Outlook 2011 (RGE) as well as Apple Mail (MBOX) 

 Converts Outspring Mail (EML, F.EML) to Outlook 2011 (RGE) as well as Apple Mail (MBOX) 

 Converts Opera Mail (MBS) to Outlook 2011 (RGE) as well as Apple Mail (MBOX) 

Key Features of Stellar Mail Converter: 

 Converts Apple Mail (MBOX) to Outlook 2011 (RGE) 

 Converts Apple Mail (EMLX) to Outlook 2011 (RGE) 

 Converts Outlook 2011 Backup File (OLM) to Apple Mail (MBOX) 

 Converts Thunderbird (MBOX) to Outlook 2011 (RGE) as well as Apple Mail (MBOX) 

 Converts PostBox (MBOX) to Outlook 2011 (RGE) as well as Apple Mail (MBOX) 

 

 

 



 

Installation Procedure 

Before installing the software, check that your computer meets the minimum system requirements: 

Minimum System Requirements: 

 Processor : Intel Processor 

 Operating System : Mac OS X 10.7 and above 

 Memory : 1 GB RAM 

To install the software, follow these steps:  

1. Unzip StellarMailConverter.dmg.zip file. 

2. Double-click the dmg file. This will mount a virtual volume - StellarMailConverter. 

3. Drag StellarMailConverter application from mounted virtual volume to Applications folder. 

4. To launch the software, double-click on Stellar Mail Converter in Applications folder. 

5. Accept the License Agreement and the main window of Stellar Mail Converter software is 

displayed 

Note: To remove the software, drag and drop Stellar Mail Converter from Applications folder to Trash. 

  

 

 

 

 

 

 

 

 



Launching the Software 

You can use any of the following methods to start Stellar Mail Converter: 

 Double-click  Stellar Mail Converter in Applications folder, 

Or, 

 Double-click  Stellar Mail Converter desktop shortcut (if you have created one), 

Or, 

 Click Stellar Mail Converter icon in the dock (if it exists). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

User Interface 

Stellar Mail Converter software has a very easy to use Graphical User Interface. User interface contains 

features required for conversion. 

After launching the software, you will see the main user interface as shown below: 

 

The user interface contains Menus and Buttons that let you access various features of the software with 

ease. 

 

 

 

 



Menus 

StellarMailConverter Menu 

About StellarMailConverter 

Use this option to read more information about 

the software. 

Services 

Use this option to browse the services offered by 

the software. 

Hide StellarMailConverter 

Use this option to hide the icon of this software 

on your screen. 

Hide Others 

Use this option to hide other software icons on 

your screen. 

Quit StellarMailConverter 

Use this option to quit Stellar Mail Converter. 

 

 

 

File Menu 

Open File 

Click on this option and select the desired file 
from which you want to convert the data.  

Save Converted File 

Use this option to save the converted file in the 
desired location. 

 

Tools Menu 



 

Register 

Use this option to register the software after 
purchasing. 

 

 

Help Menu 

Help Topics 

Use this option to view the help manual for the 

software. 

Order Stellar Mail Converter 

Use this option to buy Stellar Mail Converter. 

Email to Stellar Support 

Use this option to send an e-mail to 

stellarinfo.com. 

View Support Section 

Use this option to view support page of 

stellarinfo.com. 

Submit Enquiry 

Use this option to submit enquiry to 

stellarinfo.com. 

View Knowledgebase Articles 

Use this option to visit Knowledgebase articles 

of stellarinfo.com. 
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Buttons 

 

 

Click this button to open help manual for the software. 

 

 

Click this button to select the desired file from which you want to convert the data.  

 

 

Click this button to save the converted file in the desired location. 

 

 

Click this button to start the conversion process. 

 

 

Click this button to stop the conversion process. 

 

 

 

 

 

 

 

 

 

 

 

 



 

Ordering the Software 

Click here to know more about Stellar Mail Converter. 

To purchase the software online, please visit http://www.stellarinfo.com/email-tools/email-converter-

mac/buy-now.php   

Alternatively, click Order Stellar Mail Converter in Help Menu to purchase the software online.  

Select either of the methods given above to purchase the software. 

Once the order is confirmed, a serial number will be sent to you through e-mail, which would be required 

to activate the software. 
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Registering the Software  

To register Stellar Mail Converter: 

1. Select Register from Tools menu. 

2. If you have the key, select I have a key to register the product from Stellar Mail Converter 

dialog box and click OK. Enter the registration key and click OK to register the software. 

Or,  

If you don't have the registration key, select I don't have a key to register the product to 

purchase the software online. Once you purchase the software, you'll get the key required to 

register the software. 

3.  If entered key is valid, Product is registered successfully message will be displayed. Click OK. 

 

 

 

 

 

 

 

 

 

 



 

Stellar Support 

Our Technical Support professionals will give an appropriate solution to all your queries related to 

Stellar products.  

You can either call us or go to our online support section at http://www.stellarinfo.com/support/ 

For price details and to place an order, click http://www.stellarinfo.com/email-tools/email-converter-

mac/buy-now.php   

Chat Live with an Online technician at http://www.stellarinfo.com/ 

Search in our extensive Knowledgebase at http://www.stellarinfo.com/support/kb/ 

Submit enquiry at http://www.stellarinfo.com/support/enquiry.php 

E-mail to Stellar Support at support@stellarinfo.com 

Support Helpline 

Monday to Friday [ 24 Hrs. a day ] 

USA (Toll free Pre Sales Queries) +1-877-778-6087 

USA (Post Sales Queries) +1-732-584-2700 

UK (Europe) +44-203-026-5337 

Australia & Asia Pacific +61-280-149-899 

Netherlands Pre & Post Sales 

Support 
+31-208-111-188 

Worldwide +91-124-432-6777 

Email Orders    orders@stellarinfo.com 
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Select Mailbox 

To select a mailbox for conversion: 

 In the main window of the Stellar Mail Converter, click on Open button on the tool bar to open 

the desired file.  

Or, alternatively, you can also click on Open File option in the File Menu to select the file to be 

converted. 

 Select the format of the mailbox that you want to convert from the Choose Mail Client list box. 

 By default, the location of the database file is mentioned in the Select Database File box. Click 

Browse to select the mailbox from the different location. 

 

  Click Start button to start the conversion process. 



 

 

Note: To select hidden Apple Mail, Thunderbird, PostBox, Eudora, SeaMonkey, MailMate, Outspring Mail 

and Opera Mail mailboxes, copy them to preferred location in order to select them. 

 

 

 

 

 

 

 

 



Preview Mailbox Items 

Once you select mail client and press 'Start' button, the software starts the process of conversion. After 

the process is finished, a preview of converted mailbox is generated in a three pane window. 

 

The left pane shows mail item folder as Mails, in a tree view. The middle pane displays the list of items in 

a single mail item folder and the right pane shows the content of selected individual item. To see the 

content of a mail item folder, simply click on it in the tree view. 

 

 

 

 

 



 

Save the Converted File 

After the scanning of the mailbox you can save the converted file to Outlook 2011 (RGE) and Apple Mail 

(MBOX) format. To save the file, follow the underlying steps: 

 In the main window of the Stellar Mail Converter, click on Open button on the tool bar to open 

the desired file.  

Or, alternatively, you can also click on Open File option in the File Menu to select the file to be 

converted. 

 Select the folder from the left pane of the preview window. Click on Save button on the tool bar to 

save the converted files. 

Or, alternatively, you can also click on Save Converted File option in the File Menu to perform the 

same task. 

 Select the format in which converted mailbox has to be saved. Select Outlook 2011 to save 

converted file in '.rge' format or Select Apple Mail to save converted file in '.mbox' format.  

 Click OK button. 



 

 A 'Open Directory' dialog box is displayed. Select the destination path for saving the file. Click on 

'Open' button to start the saving process. 

 A dialog box is displayed showing progress of the saving process. You can click Stop button in 

the dialog box to stop the file save process. 



 

 

 The file will be saved by the name 'Main Identity.rge' or 'Main Identity.mbox'. A 'File Saved 

Successfully' dialog appears. 

 

 

 

 

 

 

 

 



Import Converted Mailbox to Apple Mail 

To import the converted mailbox to Apple Mail: 

 Open Apple Mail. 

 From File Menu, select Import Mailboxes. 

 

 In Import dialog box, select Files in mbox format and click Continue. 

 

 Select the mailbox you want to import and click Choose. 



 

 

The selected mailbox will be imported to Apple Mail. Click Done to view the mailbox. 

 

 

 

 

 

 

 

 

 

 

 

 

 



Import Converted Mailbox to Outlook 2011 

To import RGE file in Microsoft Outlook 2011: 

 Open Microsoft Outlook 2011. Select Import from File Menu. 

 

 In Begin Import dialog box, select Entourage information from an archive or earlier version. 

Click right arrow to continue. 

 

 In Choose an Application dialog box, select Entourage archive (.rge). Click right arrow to 

continue 



 

 

 In Import dialog box, locate and select the file that you want to import. Click Import.  

 

 

 

 

 

 

 

 



FAQs 

1. What does the Stellar Mail Converter do? 

Stellar Mail Converter software converts mailboxes from Apple Mail (MBOX, EMLX), Thunderbird 

(MBOX), PostBox (MBOX), Outlook 2011 Backup File 2011 (OLM), Eudora (MBOX), SeaMonkey 

(MBOX), MailMate (EML), Outspring Mail (EML, F.EML) and Opera Mail (MBS) to Apple Mail (MBOX) 

and Outlook 2011 (RGE), after which they can be imported in Apple Mail / Outlook 2011 to view the 

complete mail body, including the attachments. 

2. Is it necessary to install MS Outlook on the computer before converting mailboxes?  

You can convert mailboxes to Outlook 2011 format without installing MS Outlook on your computer. 

However, to view the converted mailbox, you need to install MS Outlook on your computer. 

3. What is the difference between demo version and full version of Stellar Mail Converter? 

Demo version of the software allows you to preview the mailbox data. To save the converted mailbox 

data, you need to purchase the software. 

4. How do I extract selective folders from my source mailbox? 

The software facilitates you to select the desired folders from the scanned list to perform selective 

conversion. This is useful when you don’t require converting the complete Mailbox. 

5. What are the steps to open a RGE file in MS Outlook? 

To import RGE files in MS Outlook, please refer to Import Converted Mailbox to Outlook 2011 section. 

6. What are the steps to open a MBOX file in Apple mail? 

To import MBOX file in Apple mail, please refer to Import Converted Mailbox to Apple Mail section. 

 

 

 

 

 



 

Legal Notices 

Copyright 

Stellar Mail Converter software, accompanied user manual and documentation are copyright of Stellar 

Information Technology Private Limited, with all rights reserved. Under the copyright laws, this user 

manual cannot be reproduced in any form without the prior written permission of Stellar Information 

Technology Private Limited No Patent Liability is assumed, however, with respect to the use of the 

information contained herein. 

Copyright © Stellar Information Technology Private Limited. All rights reserved. 

Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 

to change without notice. 

STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED PROVIDES NO WARRANTY WITH 

REGARD TO THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY 

EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR 

ANY PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING STELLAR 

INFORMATION TECHNOLOGY PRIVATE LIMITED ASSUMES NO LIABILITY FOR ANY DAMAGES 

INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL ERRORS 

OR OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND 

THE MANUAL. IN NO EVENT SHALL STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED, 

BE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES, 

WHETHER BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF OR IN CONNECTION 

WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN OR THE USE 

THEREOF. 

Trademarks 

Stellar Mail Converter® is a registered trademark of Stellar Information Technology Private Limited 

Mac OS X® is a registered trademark of Apple Inc. 

All Trademarks Acknowledged. 

All other brands and product names are trademarks or registered trademarks of their respective 

companies. 



License Agreement 

Stellar Mail Converter 

Copyright © Stellar Information Technology Private Limited INDIA 

www.stellarinfo.com 

All rights reserved. 

All product names mentioned herein are the trademarks of their respective owners. 

This license applies to the standard-licensed version of  Stellar Mail Converter. 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing this 

software, unless you have a different license agreement signed by Stellar Information Technology Private 

Limited 

If you do not agree to all of the terms and conditions of this License then do not copy, install, distribute or 

use any copy of Stellar Mail Converter with which this License is included, you may return the complete 

package unused without requesting an activation key within 30 days after purchase for a full refund of 

your payment. 

The terms and conditions of this License describe the permitted use and users of each Licensed Copy of 

Stellar Mail Converter. For purposes of this License, if you have a valid single-user license, you have the 

right to use a single Licensed Copy of Stellar Mail Converter. If you or your organization has a valid multi-

user license, then you or your organization has the right to use up to a number of Licensed Copies of 

Stellar Mail Converter equal to the number of copies indicated in the documents issued by Stellar when 

granting the license. 

Scope of License 

Each Licensed Copy of Stellar Mail Converter may either be used by a single person or used non-

simultaneously by multiple people who use the software personally installed on a single workstation. This 

is not a concurrent use license. 

All rights of any kind in Stellar Mail Converter, which are not expressly granted in this license, are entirely 

and exclusively reserved to and by Stellar Information Technology Private Limited You may not rent, 

lease, modify, translate, reverse engineer, decompile, disassemble or create derivative works based on 

Stellar Mail Converter nor permit anyone else to do so. You may not make access to Stellar Mail 

http://www.stellarinfo.com/


 

Converter available to others in connection with a service bureau, application service provider or similar 

business nor permit anyone else to do so. 

Warranty Disclaimers and Liability Limitations 

Stellar Mail Converter and all accompanying software, files, data and materials are distributed and 

provided AS IS and with no warranties of any kind, whether expressed or implied. You acknowledge that 

good data processing procedure dictates that any program including Stellar Mail Converter must be 

thoroughly tested with non-critical data before there is any reliance on it and you hereby assume the 

entire risk of all use of the copies of Stellar Mail Converter covered by this License. This disclaimer of 

warranty constitutes an essential part of this License. In addition, in no event does Stellar authorize you 

or anyone else to use Stellar Mail Converter in applications or systems where its failure to perform can 

reasonably be expected to result in a significant physical injury or in loss of life. Any such use is entirely at 

your own risk and you agree to hold Stellar harmless from any and all claims or losses relating to such 

unauthorized use. 

In no event shall Stellar Information Technology Private Limited or its suppliers be liable for any special, 

incidental, indirect, or consequential damages whatsoever (including, without limitation, damages for loss 

of business profits, business interruption, loss of business information, or any other pecuniary loss) 

arising out of the use of or inability to use the software product or the provision of or failure to provide 

support services, even if Stellar Information Technology Private Limited has been advised of the 

possibility of such damages. In any case, Stellar Information Technology Private Limited’s entire liability 

under any provision shall be limited to the amount actually paid by you for the software product. 

General 

This License is the complete statement of the agreement between the parties on the subject matter and 

merges and supersedes all other or prior understandings, purchase orders, agreements and 

arrangements. This License shall be governed by the laws of the State of Delhi, India. Exclusive 

jurisdiction and venue for all matters relating to this License shall be in courts and fora located in the 

State of Delhi, India and you consent to such jurisdiction and venue. There are no third party beneficiaries 

of any promises, obligations or representations made by Stellar herein. Any waiver by Stellar of any 

violation of this License by you shall not constitute nor contribute to a waiver by Stellar of any other or 

future violation of the same provision or any other provision of this License. 

Copyright © Stellar Information Technology Private Limited. All rights reserved. 

 



About Stellar 

Stellar Information Technology Private Limited is a trusted name in the field of Data Recovery and Data 

Protection Software for more than a decade. We provide the widest range of Data Recovery Products. 

Our range includes Data Recovery Software for almost all Operating Systems and File Systems. 

Product line: 

Data Recovery 

A widest range of data recovery software that helps you recover your valued data lost after accidental 

format, virus problems, software malfunction, file/directory deletion, or even sabotage!. More Info >> 

File Recovery 

The most comprehensive range of file undelete and unerase software for Windows and MS office repair 

tools. More Info >> 

Database Repair 

A wide range of database repair software to help you repair corrupted Microsoft SQL Server database, 

Microsoft Access database, MySQL database, Oracle database, SharePoint Database, SQL Anywhere 

Server and Interbase database. More Info >> 

Email Recovery 

A wide range of mail recovery, mail repair and mail conversion applications for MS Outlook, MS Outlook 

Express and MS Exchange useful in instances of data loss due to damages and corruption of Email. 

More Info >> 

Data Protection 

A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring Applications to ensure 

complete data protection against hard drive crash. More Info >> 

Data Sanitization 

Data cleanup and file eraser utility can delete selected folders, groups of files, entire logical drives, 

System Traces & Internet traces. Once the data have been removed using Stellar Wipe - Data File eraser 

utility, it is beyond recovery limits of any Data Recovery Software or utility. More Info >> 

For more information about us, please visit www.stellarinfo.com 

http://www.stellarinfo.com/disk-recovery.htm
http://www.stellarinfo.com/file-repair/file-repair-software.php
http://www.stellarinfo.com/database-recovery.htm
http://www.stellarinfo.com/mail-recovery.htm
http://www.stellarinfo.com/prevent-dataloss.htm
http://www.stellarinfo.com/prevent-dataloss.htm
http://www.stellarinfo.com/

